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Introduction to the Internet   
 
The Internet is a worldwide “network of 
networks.” Government, education, and 
businesses are joined by individual computer 
users accessing the Internet. Individuals as well 
as businesses can also publish information on 
the Internet. 
 
Web pages are viewed in a Web browser, and 
stored on another computer, called a Web 
server. The Web server contains folders, and 
files  much like your own computer.  A viewer 
accesses a document by typing a URL or 
address into a browser.    
 
The pages you view on the Web are created 
using the Hypertext Markup Language, or 
HTML. The documents contain text, graphics 
and links to other files, plus the HTML tags. 
The viewer’s browser will interpret the tags and 
display the page.  When you click on a 
hyperlink, the viewer goes to a new page, or to 
new location. 
 
The software you will need for web authoring 
includes: 

• A Web browser to view the page,  

• A text editor to edit the HTML file, 

• An FTP program to upload the page 
 

Planning Web Sites 
 
When creating a Web site, it is helpful to do 
some planning before starting work in 
Dreamweaver.   
 
• First think about the purpose of your Web 

site. What do you want your Web site to 
do? 

 
• After that, think about who will visit your 

site. Are they new to the Internet or 
experienced Web surfers?  

 
• Next, start to organize the content. What 

topics will you have on your site?  
 
• The next step is to group topics into pages. 

Create an outline or diagram for your site. 
How will the information flow? How will 
visitors navigate the site?   

 
• Finally, think about what you want the site 

to look like. Looking at other Web sites can 
be helpful in choosing what colors you to 
use, and other design ideas. 

 
Introduction to Dreamweaver 
 
The Dreamweaver work environment makes it 
easy to build Web pages. You can visually lay 
out your pages using techniques similar to 
those you’d use with a word processing or page 
layout program. In addition, you access tools 
directly related to Web content. 
 
The Dreamweaver working environment 
contains many of the same features as any other 
Windows application, but it also has some 
added elements. 
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Menu Bar 
The top bar, the Menu bar, is similar to other 
word processing menu bars with the addition 
of a few extra menus: Modify, Text, 
Commands, and Site. 
 
Insert Bar 
The Insert bar contains tools that allow you to 
add a wide variety of content to your pages. 
The default category in the Insert Bar is the 
Common category, which contains a number 
of buttons that allow you to add various 
elements to Web pages, including images, 
hyperlinks, tables, rules, and objects such as 
Flash or Shockwave files. In addition, the tabs 
across the top of the Insert Bar allow you 
access to other categories such as: 
 
• The Layout category contains tools for 

working with tables.  
• The Text category contains additional 

buttons to apply formatting to your pages. 
• The Tables category lets you add rows and 

columns to a table while working with the 
HTML code.  

• The Frames category contains buttons that 
assist you in building a frameset.  

• The Forms category contains tools to help 
you build forms.  

• The Templates category includes tools for 
creating a template.  

• The Characters category lets you add 
typographic characters to your pages.  

• The Media category can be used to add 
objects such as Flash files or Java applets. 

• The Head category lets you add meta tags 
to your pages.  

• The Script and Application categories 
allow you to add scripts and database 
features to your Web pages. 

 
Document Toolbar 
The Document toolbar contains buttons to 
toggle between different views, as well as file 
management commands. 
 
Status Bar 
The Status bar contains the Tag Selector, the 
Window Size drop-down list, and the 
Document Size and Download Time field. 

 
Property Inspector 
The Properties inspector contains settings that 
allow you to specify the properties of text and 
other objects that you place on Web pages. 
The settings in the Properties inspector change 
to reflect the particular object you are working 
with. You can use the Properties inspector to 
format text, set table borders, specify link 
destinations, and specify many other attributes 
of page objects. 
 
Panel Groups 
The panel groups on the right to let you view 
and change information about the pages and 
their contents. There are Design, Code, 
Application, File, and Answer panels. You will 
work with a part of the Files panel group called 
the Site panel. 
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Site Panel 
The Site panel allows you to view and manage 
the various files that comprise the site. In 
addition, you will use the Site panel to upload 
files to a Web server.   
 
Preview a Page 
When you build pages directly in 
Dreamweaver, you can see what they will look 
like as you work with them. However, in order 
to test the various page links or view any 
JavaScript or Flash or Shockwave files, you 
need to actually preview the pages in a Web 
browser.  You can set multiple browsers to be 
available in the Preview in Browser in the File 
menu.  
 
Examining a Page 
 
1.  From the Start button, go to Programs, 
then choose Macromedia and finally launch 
Dreamweaver MX. 
 
2. Choose File and Open. Navigate to the 
Example folder in the Dreamweaver MX 
folder. 
 
3. Select the index.htm file, and click Open. 
The page opens in Design view. 
 
4. Choose File and Preview in Browser and 
[Installed Browser].   
 
5. Click the Store Info text link at the bottom 
of the page.  
 
6. Close the browser to and return to 
Dreamweaver. 
 

Dreamweaver Views 
 
As you build your Web page, Dreamweaver 
MX generates the HTML code for a browser 
to read the Web file that you create. You can 
choose from three Views: 
    
• In Design view, you see the page as it 

would look  like to the viewer, but the links 
are not “live.” 

• In Code view, you can see and edit the 
HTML and other code on the page.  

• In Code and Design view,  your screen is 
split so that you can see the HTML code 
created, and you can see the  changes on 
the page as you alter the code. 

 

 
 
You can also work with the HTML code using 
the Tag Selector in the Status bar. 
 
Looking at HTML Code 
 
1. On the Document toolbar, click the Show 
Code View button. 
 
2. On the Document toolbar, click the Show 
Code and Design Views button. 
 
3. On the Document toolbar, click the Show 
Design View button. 
 
4. You can use the tag selector in the Status 
Bar to select parts of your document. In the 
Status Bar, click on the first <p> tag. The 
entire first paragraph is selected. 
 
5. Close the index.htm document. Click No 
to discard the changes.    
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Creating a Web Site 
 
In Dreamweaver, a defined Web site is the 
folder containing all of the files necessary for 
the site’s operation, including HTML, 
graphics, and other files. Before you create a 
Web page you must create the Web site for it. 
 
When defining the site, you can set up certain 
site attributes, and leave others to be set up at a 
later time. For example, you do not have to 
specify remote settings that you will need for 
uploading when you initially set up the site. 
You will now define the Edens Gardens site. 
 
Defining a New Web Site 
  
1. Choose Site menu and New Site. A dialog 
box appears. Make sure the Basic tab is active. 
 
2. Type Edens Gardens for the site name. The 
site name is used only by Dreamweaver. 
 
3. Click Next. 
 
4. You will not use advanced server technology 
(ASP or ColdFusion) in this Web site. Click on 
the No, I Do Not Want To Use A Server 
Technology button, then click Next. 
 
5. While developing the site, you will edit the 
site files locally. Make sure the Edit Local 
Copies Directly on my Local Machine radio 
button is selected. 
 
6. You now need to select the folder where you 
will store the site files for the Edens Gardens 
site. Click the folder icon to select the local 
folder. A dialog box appears. 
 
7. Navigate to the Dreamweaver MX folder. 
Double click the Edens Gardens folder and 
click Select. Then click Next. 

8. You will add the remote server information 
at a later time. From the Remote Server drop-
down list, choose None. Click Next. 
 
9.  You now see a summary screen. Click Done 
to complete the site definition. 
 
Creating a Basic Web Page 
 
You can add and edit text in a Dreamweaver 
document using the same basic techniques that 
you would use in a word processer. You will 
now begin building the Web site by creating a 
simple Web page that contains store 
information for Edens Gardens. 
 
Adding Text 
 
1. You will create a new store information page 
for Edens Gardens. Choose File menu and 
New. A dialog box appears.   Make sure the 
General tab is active. Choose the Basic Page 
category if necessary, and choose the HTML 
page. 
 
2. Click Create. 
 
3. Type the following text, pressing Enter at 
the end of each line: 

Store Information 
Edens Gardens 
567 Nursery Lane 
Atlanta, GA 30089 
Phone: 
(717) 555–1234 
E-mail: 
info@edensgarden.com 
Store Hours: 
Mon-Sat 7am - 9pm 
Sun 9am - 7pm 



__________________________________________ 
Computer Services’ Central Technology Services 
www.ohio.edu/technology/ 

5 
 

4. Each time you press Enter, you create blank 
lines. This is because you are actually inserting 
a paragraph break.  You will remove the extra 
line by using line breaks instead of paragraph 
breaks.  
Click to the left of “Atlanta” and press 
Backspace. You have removed the paragraph 
break.   
 
5. Hold down Shift and press Enter. This 
inserts a line break. 
 
6. You will also remove the paragraph breaks 
between the “store hours” lines, the "phone" 
lines, the "email" line. Then replace them with 
line breaks.   

Edens Gardens 
567 Nursery Lane 
Atlanta, GA 30089 
 
Phone: 
(717) 555–1234 
 
Email: 
info@edensgarden.com 
 
Store Hours 
Mon-Sat 7am-9pm 
Sun 9am-7pm 
 

Text Formatting 
 
To bold or to italicize text, press the “B” or 
the “I” button in the Properties inspector.      
 
Font Size 
When you select the size for text, those sizes 
are based on the default size in each viewer’s 
Web browser. You can select from two types of 
sizes: absolute and relative. 
 
To select absolute sizes, you can choose the 
values “1” through“7” from the Size drop-
down list in the Properties inspector. A “1” is 

the smallest size, and “7” is the largest. A value 
of “3” is the default font size. 
 
You select relative sizes by choosing the 
values“-7” through“+7” in the Size drop-down 
list in the Properties inspector. The relative size 
of “+2” is two sizes larger than the default size, 
which is an absolute size of “5.”  
  
Paragraph Formats 
You can also apply sizes to headings and 
paragraphs using the Format drop-down list in 
the Properties inspector. There are six heading 
levels, with “Heading 1” being the largest. The 
various heading formats will change sizes and 
bold. In addition, you can select the 
“Paragraph” format which uses the default text 
size set in the browser. 
  
Font Style 
When selecting a font style for text, use fonts 
that are likely to be installed on the viewer’s 
computer. The default font is Times New 
Roman or Times. You apply fonts to selected 
text by choosing a font set from the Font list in 
the Properties inspector. 
 
Font Color 
There are 216 Web safe non-dithering colors. 
These colors will display the same in any 
browser and any platform. You can select a 
color by choosing it from the palette or typing 
in the 6-digit hexadecimal value in the 
Properties inspector. 
 
Formatting Type 
  
1. First, Click to place the insertion point in 
the text “Store Information.” In the 
Properties inspector, choose Heading 2 from 
the Format drop-down list.  
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2. Select “Edens Gardens.” In the Properties 
inspector, click theBold button. 
 
3. You will also set an absolute size for the 
text. In the Properties inspector, choose the 
4 from the Size drop-down list.  
 
4 Next you will select a font style. With the 
“Edens Gardens” text still selected, choose 
Verdana, Arial, Helvetica, Sans-Serif from 
the Font drop-down list. 
 
5. With the “Edens Gardens” text still 
selected, choose the fourth blue color in the 
first column from the Color palette in the 
Properties inspector (#000099). 
 

 
Edens Gardens 
567 Nursery Lane 
Atlanta, GA 30089 
 
Phone: 
(717) 555–1234 
 
Email: 
info@edensgarden.com 
 
Store Hours 
Mon-Sat 7am-9pm 
Sun 9am-7pm 
 

Page Properties 
 
The Page Properties submenu of the Modify 
menu allows a number of settings that you 
apply to the entire page. For example, the text 
color, and the background color. 
 

Page Title 
A Web page may contain a title that is separate 
from the actual name of the file.  The title will 
appear in the title bar of the browser window 
and be used for the bookmark.  
 
Page Background 
You can change the page background. You can 
select a solid color or a background image.  If 
you use a background image, it will tile to fill 
the current page size.  Web pages can display 
two types of images: GIF and JPG formats.  
 
Saving Web Pages 
 
When you save a Web page and name it, the 
file name should only include lower case 
characters, and no punctuation and spaces. The 
file should end with a .htm or .html. 
 
Specifying Page Properties   
 
1. Choose Modify and Page Properties. A 
dialog box appears. 
 
2. In the Title field, type:  Store 
Information. 
 
3. From the Background drop-down list, type 
in #669900.  Click OK.   
 
4. Choose File and Save.  It should save it in 
the Edens Gardens folder. 
 
5. In the File Name field, type store. Click 
Save. Dreamweaver will add the “.htm”.  
Close the store.htm file.  
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Adding Content to a Page 
 
Lists 
 
There are three types of lists available on the 
Web: ordered  lists, unordered lists, and 
definition lists. In an unordered list, each item 
is preceded by a bullet. In an ordered list, each 
item is preceded by a number. In a definition 
list, each alternating item is formatted as a 
term or its definition. In addition, you can use 
the Text Indent and Text Outdent buttons to 
indent list items. This allows you to have sub-
items in a list.   
 
Creating a List 
  
1. Using the Site panel, open the store.htm 
document. 
 
2. Select the text from "Edens Garden" 
through “Store Hours.” 
 
3. First format the selection as an ordered list. 
In the Properties inspector, click the Ordered 
List button.   
  
4. Now with the text still selected, in the 
Properties inspector, click the Unordered 
List button. 
 
• Edens Gardens 

567 Nursery Lane 
Atlanta, GA 30089 

 
• Phone: 

(717) 555–1234 
 

• Email: 
info@edensgarden.com 

 

• Store Hours 
Mon-Sat 7am-9pm 
Sun 9am-7pm 

 
Images 
 
Graphic File Types 
There are two types of graphics you may use on 
your pages: GIF and JPEG. GIF images are 
limited to 256 colors, and are most useful for 
images with few colors. In addition, GIF 
images support transparency, so you can have 
page backgrounds show through parts of the 
image. 
 
JPEG images use compression to greatly 
reduce file size, allowing for faster 
downloading. JPEG images are best for 
photographs and other images that contain 
more than 256 colors. These images do not 
support transparency. 
 
Inserting Images 
 
Adding an image to a page is simple. You can 
either use the Image button in the Common 
pane of the Insert bar, or you can choose the 
Insert••Image command.   An inserted image 
is placed at the insertion point on the page. 
The HTML establishes a link from the Web 
page to the image file. The image itself  is a 
separate file. 
 
Inserting Images on a Page 
 
1. Click to place the insertion point after 
“Directions” and press Enter. 
  
2. Choose Insert and Image command. A 
dialog box appears. 
 
3. Navigate to the graphics folder inside the 
Edens Gardens folder. Select directions.gif, 
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and click OK. The image is inserted at the 
insertion point. 
 
 

 
 
 
Image Properties 
Once you add an image to the page, you can 
change the way the image will display on the 
page. You can specify the display height and 
width of the image, its alignment, spacing 
between the image and other page elements, 
and an alternate text label. 
 
Image Size 
The Width and Height fields in the Properties 
inspector allow you to control the display size 
of the image on the page. 
 
Image Spacing 
You can place blank space vertically or 
horizontally around an image by entering a 
value in the V Space or H Space fields. The 
values are expressed in pixels. 
 
Alignment 
You can set the horizontal alignment of an 
image using the Alignment list in the 
Properties inspector. The default alignment will 
align the bottom of the image with the baseline 
of the surrounding text. 
  

Image Label 
It is helpful to the viewer to have a label for the 
image that appears along with a placeholder. 
The alternate text is also used by software that 
reads Web pages aloud. To specify a label, you 
type it into the Alt field in the Properties 
inspector.  
  
Setting Image Properties 
 
1. You will begin by labeling the image. Make 
sure the directions image is selected. In the 
Properties inspector, type Map in the Alt 
field and press Enter. 
 
2. You will also add horizontal spacing around 
the image. In the Properties inspector, type 
10 in the H Space field, and press Enter. Ten 
pixels of space is added to the left and right 
side of the image. 
 
3. In the Properties inspector, choose 
Middle from the Align drop-down list. Next,  
in the Properties inspector, choose Right 
from the Align drop-down list. 
 
4. Return the alignment setting to Default.  
Save and close store.htm. 

 
 
Tables 
 
It can be difficult to place elements on the page 
where you want them. As the viewer resizes 
their browser window, text and images will 
move within the borders of the browser 
window.   Many authors use tables to place 
page elements in specific places, and to control 
text flow.   
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Creating Tables 
To add a table to a page, you can click on the 
Insert Table button in the Insert bar, or you 
can choose the Insert  and Table command. 
Then, you select how many rows and columns 
will be in the initial table. In addition, you can 
set the table’s width, the cell border, cell 
padding, and cell spacing. 
 
Table Width 
When you select the width for a table, you can 
set a specific width in pixels, or a width in 
percentage of the browser window. If you 
choose a pixel width, the table’s width is fixed. 
If you choose a percentage width, then if the 
viewer widens their browser window, the table 
will also widen. 
 
Cell Borders  
The Cell Borders setting puts borders between 
the table cells and around the outside of a 
table. The larger the value in the Cell Borders 
field, the thicker the border. If you do not 
want borders for the table, set the Cell Borders 
value to 0. 
 
Cell Padding and Cell Spacing 
The Cell Padding setting controls the space 
between the edge of the cell and its contents. 
The larger the value in the Cell Padding 
setting, the further the distance between the 
cell’s edge and its contents. 
 
The Cell Spacing setting controls the amount 
of space between table cells. The larger the 
value in the Cell Spacing setting, the larger the 
space between the cells. 
 
Inserting a Table 
 
1. Using the Site panel, open the index.htm 
file. Place the curser below the logo. 
 

2. You will place a table in the file. Click on 
the Common tab in the Insert bar. 
 
3. Then, click the Insert Table button. A 
dialog box appears. 
 
4. In the Rows field, type 3. In the Columns 
field, type 2. 
 
5. You will set a width for the table that is a 
percentage of the screen. From the Width 
drop-down list, choose Percent, and in the 
Width field, type 80. 
 
6. You will set the Cell Padding to 0 and Cell 
Spacing are set to 5. Click OK.  . 
 
7. You will now type some text into the table. 
Click in the cell in the first column and third 
row of the table. Type: 

Welcome to Edens Garden.  We have 
been around since nearly the 
beginning of time, when Adam, Eve 
and later their sons decided to turn 
their love for flowers and for helping 
people into a business. 
For more information, click  on one of 
the images above. 
 

You may expand the column to fit the text, by 
grabbing the border and dragging it. 
 
  
  

Welcome to Edens Garden.  We have 
been around since nearly the 
beginning of time, when Adam, Eve 
and later their sons decided to turn 
their love for flowers and for helping 
people into a business. For more 
information, click  on one of the 
images here. 
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Inserting Graphics in Table   
 
8. Next you will place an image into the table. 
Click in the cell in the first column and first 
row of the table. 
 
9. In the Insert bar’s Common panel, click 
the Image button. In the dialog box, navigate 
to the graphics folder, choose flower.jpg, and 
click OK.   
 
10. You will now label the image you just 
placed. Make sure the image is selected, and 
type flower in the Alt field in the Properties 
inspector. 
 
11. You will add another image to the table. 
Widen the second column by dragging the 
border separating the first and second columns. 
Now click in the second column.  
 
12. Then, in the Insert bar’s Common panel, 
click the Image button. This time, choose 
monthly.jpg, and click OK.  Type monthly in 
the Alt field.  In the second row, insert the 
image whats.jpg and store.jpg.  Type their 
names in the Alt field.  
 
13. Before finishing, we will merge the two 
cells of the last row together.  First, select the 
entire row.  Now click the Merge Cell button 
in the Properties inspector. 
 
14. Save the index.htm file. 
 
15. Go to the File menu and choose Preview 
in Browser and then select Installed Browser. 
 

 

 
 
Adding Hyperlinks 
 
Types of Links 
 
When you click on a hyperlink, whether it is 
text or an image, you are sent to a new 
location.  It could be to a new file in a new site, 
or to a new file in the same site, or to a named 
spot in the same file. 
 
Types of Addresses 
 
Just like there are three types of links, there are 
three different types of addresses you may need 
to specify.   
 
• The Absolute address (URL) is the 

complete address that includes the domain 
or server name, the folder or directory 
name, and the file name.  

• The Relative address in the short address 
that only includes the folder or file name.   

• The Anchor address is the address to a 
named location within a file.  

 
So when do you use each of these? When your 
link refers to a file on a different server, you 
specify the absolute address.  When your links 
refer to files within the same Web server and 
folder (directory) you do not need to specify 
the domain name and folder. Or, simply use 
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the name of the file as the link. Finally, when 
your link refers to a named location within a 
file, you must use # (pound sign) followed by 
the anchor name you gave it. 
 
How to Create Links 
You will now create the various links in your 
site. Once you select the text or image that you 
want to use as the link, you can use one of the 
following methods to create links: 
 
• Type links manually into the Link field of 

the Properties inspector. 
• Use the Hyperlink button in the Insert bar 

and enter information in the dialog box. 
• Use the Browse for File button in the 

Properties inspector. 
 
 Creating Relative Links 
  

 
 
1 Next you will add some relative links to the 
index file. Open the index.htm file.   
 
2. Click to place the insertion point after the 
table.  Press Enter. 
 
3. Type: | Flower Info | Monthly Pick | 
What’s New | Store Info. 
 
4. Place the insertion point at the beginning 
of the line you just typed. 
 
5. From the Common tab on the Insert bar, 
click the Hyperlink button on the Insert bar. 
A dialog box appears.  
 
6. Type Home in the Text field. 
 

 
 
7. Click the Browse for File button to the 
right of the Link field. A dialog box appears. 
Navigate to the Edens Gardens folder, and 
select index.htm.  Click OK. Click OK again. 
 
8. Select the text Flower Info. In the 
Properties inspector, click the Browse for 
File button to the right of the Link field. In 
the dialog box, find and select 
flowerinfomain.htm. Click OK. 
 
9. Select the text Monthly Pick. Click the 
Browse for File button to the right of the  
Link field.  In the dialog box, find and choose 
monthlypick.htm. Click OK. 
 
10. Select the text What’s New. Use any 
method to create a link to whatsnew.htm. 
 
11. Select the text Store Info and use any 
method to create a link to the store.htm. 
 
12. Save the file. A dialog box appears. 
 
13. On the File menu, click the Preview in 
Browser and choose Installed Browser.” 
 
14 Click on the “Store Info” link. Click the 
Back button to return to the page. 
 
15. Click on the “Home” link. Close the 
browser and return to Dreamweaver. 
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Absolute Hyperlinks 
 
You can use the Link field in the Properties 
inspector to link to external Internet resources, 
such as Web pages on other sites, e-mail 
addresses, etc. When adding an external URL 
link, you need to type the complete, absolute 
URL in the Link field in the Properties 
inspector. When adding an e-mail link, you can 
type the complete e-mail address in the Link 
field, or you can click the Insert E-Mail Link 
button in the Insert bar. 
 
Creating Absolute Links 
  
1. Use the Site panel to open the store.htm 
document. 
 
2. Click to place the insertion point to the 
right of the map and press Enter and type: 
Here are directions to Edens Garden’s. 
 
3. Select the text “Directions.” 
 
4. In the Properties inspector, click in the 
Link field and type http://www.directionz.com 
and press Enter. 
 
5. Preview the page in the browser. Click the 
Directionz link. . 
 
6. Go back to Dreamweaver. 
 
Creating E-mail Links 
 
7. You will now create an E-mail link, which  
will produce an E-mail form.  
 
8. Select the E-mail address: 
info@edensgarden.com. Click the Email Link 
button on the Insert bar. A dialog box 
appears. The contents of the Text field will be 
the underlined link.  

9. In both the Text and E-Mail fields, type 
info@edensgarden.com.  Click OK. 
 
10. Save and close the file. 
 
Note: If you type an e-mail address in the Link 
field, make sure to type “mailto:”  in front of  
the e-mail address. 
 
Anchors 
 
Each of the links you have created so far jumps 
to a new page, whether to this site, or to 
another site. An anchor lets you create a link 
that jumps to a particular spot on a page, 
instead of to the top of the page. An anchor is 
a name to a specific position in a file. Then you 
can link to the anchor. You will create anchors 
within the annuals.htm. 
 
Creating Anchors 
  
1. Use the Site panel to open the store.htm 

page.  
 
2. Position the insertion point before the 

“Edens Garden” text. 
 
3. On the Insert bar, click the Named 
Anchor button.  A dialog box appears. Type  
edensgarden  in the Anchor Name field. 
Anchor names are case sensitive, so remember 
how you typed the name. Click OK. An 
anchor icon appears. 
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4. Now that you have named the anchor, you 
will create the link to the anchor. Select the 
text Edens Garden that appears after the map. 
 
5. A link to a named anchor is preceded by a # 
sign. Type #edensgarden in the Link field in 
the Properties inspector, and press Enter. 
 
6. Save the store.htm file and preview it in 
the browser. Close the browser after testing 
the anchor links. 
 
7. Close and save any other open files. 
 
Uploading a Web Site 
 
The Site Map 
 
The site map gives you a graphical 
representation of your site files, allowing you to 
see the site’s structure and various file 
dependencies. You can display a site map 
within the Site panel. 
 
Using the Site Map 
 
1. Click the Expand/Collapse button in the 
Site panel. 
 
2. Click the Site Map button, and choose 
Map and Files from the Site Map drop-down 
list. The site map appears in the left pane, with 
the site files appearing in the right pane. 
 
3. You will now view the dependent files for 
the store.htm page. Click the + symbol next to 
store.htm page. A list of all the pages the 
store.htm page links to appears. 
 
4. You can view the structure of linked pages 
within the current page’s list, as well. Click the 
+ symbol next to index.htm under store.htm. 

The files linked to the index.htm page appear. 
Click the – symbol to collapse the sub-list. 
 
5. Choose View and Show Dependent Files. 
The site map now lists any images that are used 
on the page as well. 
 
6. Click the Expand/Collapse button to 
collapse the Site panel. The Site panel displays 
the file list once again. 
 
 

 
 
Checking Links 

Before uploading a site, you should verify that 
all links are functional, and that all the files you 
need will be uploaded when you upload the 
site. You can perform a check of broken links, 
external links, and orphaned files (do not have 
any links associated with them). You can view 
each of these categories by choosing them from 
the Show drop-down list in the Results panel. 
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Checking Links for a Site 
 
1. In the Site panel, choose Site and Check 
Links Sitewide. The Results panel appears at 
the bottom of the screen. 
 
2. The Broken Links category currently 
appears in the Results panel in the Show list. 
In the Link Checker tab, choose External 
Links from the Show list. The two links from 
the store information page are displayed. 
 
3. In the Link Checker tab, choose Orphaned 
Files from the Show list. The files that do not 
have any links to them are displayed. 
 
4. In the Results panel, choose Close Panel 
Group from the dropdown list at the top-
right corner. 
 

 
 
Uploading a Site 
 
Once you have checked the links, you are ready 
to set up the site for uploading. 
In order to transfer the files to your server, you 
need several pieces of information. An ISP will 
issue a user name and password with your 
account, and will give you the FTP address. If 
you want to place site files within a sub-
directory, you must also know that directory 
path.  Before you transfer site files to your Web 
space, you will edit your remote site 
information: 
 
1. In the Site panel, choose Site and Edit 
Sites. 
 

2. In the dialog box, select your site, then click 
Edit. 
 
3. In the dialog box, click on the Advanced 
tab, and select Remote Info. 
 
4. Choose FTP from the Access drop-down 
list. Enter your FTP address in the FTP Host 
field. 
 
5. If you want your site files to be placed inside 
a sub-directory within the remote site’s root 
folder, type the sub-directory path in the Host 
Directory field. 
 
6. Type your user name and password in the 
User Name and Password fields. 
You are now ready to upload your files to your 
Web space. You can also specify this 
information when defining your site for the 
first time.  
 
For this course, you will create a test folder on 
your hard disk to move the files. 
 
Uploading to Test Folder 
 
1. You will now upload the entire Edens 
Gardens site. First you will specify a folder to 
house the “remote” site. Choose Site and Edit 
Sites. A dialog box appears. 
 
2. Click on Edens Gardens in the Site list and 
click Edit. A dialog box appears. 
 
3. Click on the Advanced tab, and select 
Remote Info in the Category list. 
 
4. Choose Local/Network from the Access 
drop-down list. 
 
5. Click the Browse for File button to the 
right of the Remote Folder field. A dialog box 
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appears. Navigate to the Dreamweaver MX 
folder. Click the New Folder button. A new 
folder appears. Name the new folder “Test 
Site.” 
 
6. Make sure the Test Site folder is selected, 
and click Open. The Test Site folder appears in 
the Select field. Click Select. You return to the 
previous dialog box. 
 

  
7. Click OK. You return to the previous dialog 
box. Click Done. 
 
8. Click to select the root folder in the Site 
panel. By selecting the root folder, you signify 
that you want all of the files within the Site 
folder to be added. 
 
9. Click the Put Files button at the top of the 
Site panel. This tells Dreamweaver to load all 
your pages to the remote site. 
 
10. An alert box appears, asking if you want to 
upload the entire site. Click OK. The files are 
transferred to the Test Site folder. If you were 
uploading the site to a Web server, clicking the 
Put Files button would upload the files. 
 
11. Click the Expand/Collapse button in the 
Site panel to expand. 
 
12. Click the Site Files button to view the 
files in the remote location. The files have 
been “uploaded” to the Test Site folder. 
 

13. Click the Expand/Collapse button to 
collapse the Site panel. 
 
Uploading Changed Files 
 
If you make changes to your site on your 
computer, you must upload those changed files 
to your Web server. You would choose Edit 
and Select Newer Local from the Site panel. 
Only the changed files are selected. At the top 
of the Site panel, click the Put Files button.  
A dialog box appears. Click Yes to upload the 
dependent files along with the changed files. 
It uploads the changed files to the Test Site 
folder. 


